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ABSTRACT 
 

CubeSat projects in various universities around the world have become predominant in the 

study and research for developing CubeSats. Such projects have broadened the scope for 

understanding this new area of space research. Different CubeSats have been developed by 

other universities and institutions for different applications. The process of design, 

development and deployment of CubeSats involves several stages of theoretical and practical 

work ranging from understanding the concepts associated with communication subsystems, 

data handling subsystems to innovations in the field like implementing compatible operating 

systems in the CubeSat processors and new designs of transceivers and other components. 

One of the future trend setting research areas in CubeSat projects is the implementation of 

ROS in CubeSat. Robot Operating System (ROS) is aiming to capture the future of many 

embedded systems including Robotics. In this thesis, an attempt is made to understand the 

challenges faced during implementing ROS in CubeSat to provide a foundation for the 

OBDH subsystem and provide important guidelines for future developers relying on ROS 

run CubeSats. Since using traditional transceivers and power supply would be expensive, we 

have tried simulating Arduino to act as transceiver and power supply subsystems. Arduino is 

an open-source physical computing platform based on a simple microcontroller board, and a 

development environment for writing software for the board designed to make the process of 

using electronics in major embedded projects more accessible and inexpensive. Another 

important focus in this thesis has been to establish communication between CubeSat kit and 

Arduino. The major motivating factor for this thesis was to experiment with and come up 

with alternate ways which could prove as important measures in future to develop an 

effective and useful CubeSat by cutting down on development costs. An extensive literature 

review is carried out on the concepts of Arduino boards and ROS and its uses in Robotics 

which served as a base to understand its use in CubeSat. Experiment is conducted to 

communicate the CubeSat kit with Arduino. The results from the study of ROS and 

experiments with Arduino have been highly useful in drafting major problems and 

complications that developers would encounter while implementing ROS in CubeSat. 

Comprehensive analysis to the results obtained serve as important suggestions and guidelines 

for future researchers working in this field. 

 

Keywords: Arduino Diecimila, Arduino UNO, CubeSat kit, Robot Operating System 
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1 INTRODUCTION 

This thesis is a part of the CubeSat program at BTH. CubeSats are small artificial satellites 

which are developed for improving accessibility to space research. These satellites are 

standardized to a size of 10 cm cube and weight less than 1.33 kg. CubeSats weighing a few 

kilo grams have increased low cost access to space experimentation in low earth orbit and 

the main idea to design CubeSats as described in [1] is to use them as test beds for aerospace 

engineering education and for research in space technology with reduced costs, development 

time and minimized risks. CubeSats operating in the low earth orbit have allowed several 

universities for developing and placing in orbit student-led, student-designed, student-built 

and student-operated satellites by investigating all manner of scientifically exciting 

phenomena, while giving a competitive edge to the graduates working on these projects [21]. 

[2] Describes the Onboard Data Handling (OBDH) system as the main subsystem of a 

CubeSat that provides all the functionality and interfaces necessary to support CubeSat 

operations. The primary goal of the communication subsystem is to send commands to and 

from the CubeSat. 

 

Arduino is an open-source electronics prototyping platform based on flexible, easy-to-use 

hardware and software [28]. There are many microcontroller platforms available for physical 

computing but Arduino simplifies the process of working with microcontrollers over other 

systems by offering some advantage for students, teachers and also is intended for artists, 

designers, hobbyists, and anyone interested in creating interactive objects or 

environments [28]. The microcontroller on the board is programmed using the Arduino prog-

ramming language based on Wiring and the Arduino development environment based 

on Processing [28] and the projects using Arduino can be stand-alone or they can 

communicate with software running on a computer. The design of simulated subsystems like 

power system and transceiver for CubeSat using low cost Arduino controllers is a 

challenging task.  

 

In the past few years, the Robot Operating System (ROS) has emerged as a standard and 

open-source operating system for real-time robot control as described in [3]. ROS is an open 

source platform that aims to capture the future of robotics and other systems. We would like 

to introduce ROS in CubeSat as an established foundation for onboard software and test its 

performance on an embedded system like CubeSat as compared to robots that are more 

complicated in having multiprocessors and microcontrollers. The aim of the proposed project 

is to assess the suitability of ROS on CubeSat. 

  

1.1 Problem Statement 

A CubeSat is defined as a ten centimeter by ten centimeter satellite, having a total weight no 

more than 1 kilogram. The CubeSat standard will be a critical component in the research 

field of CubeSat. The OBDH subsystem is the heart of the CubeSat which contains the 

microcontroller installed with RTOS. There are many systems that use real time operating 

systems designed uniquely for that particular system. The software designed for different 

hardware‟s or missions is different and reusing the software for other missions may be 

complicated and time consuming. Salvo RTOS manufactured by pumpkin is costly and is to 

be purchased during the purchase of CubeSat kit that increases the overall cost. So, there is a 

need to decrease the overall cost. In the past few years, the ROS has emerged as a standard 

and open-source operating system for embedded robot control that has made a tremendous 

change in the field of Robotics. ROS currently runs only on Unix-based platforms. A study is 

made to check whether the ROS can give a foundation for the complex embedded system 

like CubeSat. ROS is an alternative replacement for RTOS. There are many subsystems 

present in CubeSat that makes CubeSat work like a satellite and these subsystems are sold 

and available commercially which are expensive. This increases the overall cost of the 

http://arduino.cc/en/Reference/HomePage
http://arduino.cc/en/Reference/HomePage
http://wiring.org.co/
http://www.processing.org/
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CubeSat project making it difficult for the small, medium organizations and Institutions to 

work on it. So, reducing the overall cost is an important challenge that can be achieved by 

simulating the subsystems using Arduino boards.     

   

1.2 Research Questions 

The main task of this thesis is to establish communication between the CubeSat kit, Arduino 

and to study the requirements for installing an ROS on the OBDH subsystem of the CubeSat. 

The research questions for this thesis are framed as follows. 

 

1) Can the ROS provide a foundation for the Onboard Data Handling (OBDH) 

subsystem of a CubeSat? 

2) What are the advantages and disadvantages of ROS in robotics with respect to 

CubeSat? 

3) What are the problems encountered during the communication of the CubeSat kit 

with Arduino? 
 

1.3 Organization of Thesis 

The outline of this thesis is provided before the specific requirements are discussed. A 

thorough background search was conducted in finding the issues involved in installing the 

ROS on OBDH and communication between the CubeSat and Arduino. In this chapter a 

description of the CubSat concept and the problems involved in CubeSat project are 

discussed. In chapter2 and chapter3, the brief history of CubeSat, OBDH, Arduino, Salvo 

RTOS and ROS are discussed. Chapter4 includes the hardware and software requirements 

for performing the experiment. Chapter5 describes the problems encountered during the 

experimentation of the thesis work. The Chapter6 and 7 explains the detailed analysis of the 

results and conclusion. Finally, in chapter8 the future work that can be done in the field of 

CubeSat based on the contributions of this thesis is discussed. The references used in the 

thesis are cited at the end of the document.  
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2 RESEARCH METHODOLOGY 

In this chapter, the different methods used in this research work are outlined. The 

methodology defines the process of research, working procedure followed by an explanation 

of the experiment. In this chapter, the constructive and qualitative methods that are used in 

our thesis work are presented. Most of the emphasis is on the qualitative research 

methodology where the literature review is conducted in the first part and an experiment is 

conducted for the later part. The references present in the references are used for finding 

more and more references. A review of the previous works is done to acknowledge the 

current knowledge to answer the research questions one and two in our research work where 

an extensive literature is carried out on the concepts of ROS and OBDH. 

 

2.1 Constructive Research 
 

There are many real world problems, the solutions of which can be found using this 

approach. In this method of research, the research need not be validated empirically as in 

other research types like exploratory research. “Constructive research method implies 

building of an artifact (practical, theoretical or both) that solves a domain specific problem in 

order to create knowledge about how the problem can be solved (or understood, explained or 

modeled) in principle that  gives results which can have both practical and theoretical 

relevance” [18].  

 
The new contribution being developed like a new theory, algorithm, model, software or a 

framework is often referred to as “construct”. It is important to observe that “constructive 

research can also be viewed as a form of conducting case which is research parallel to the 

theory illustration, theory testing and action research” [19]. In this approach, different 

information sources such as training materials, literature reviews, processes, working 

experience etc. are used for collecting the information which provides a theoretical body of 

knowledge. When applied to a problem, it produces innovative constructs which may be 

theory, algorithms, models or software making contributions to the theory of the discipline in 

which it is applied.  

 

In this approach, first the information related to Arduino and CubeSat are collected from 

different sources. The construct in the thesis is a form of conducting a case to study the 

simulation of power subsystem and transceiver subsystem using Arduino boards. This 

construct or solution generates new knowledge for further extending the theoretical, practical 

knowledge in the use of CubeSat kit and Arduino boards. The experimentation requires some 

hardware and software components like CubeSat kit and Arduino boards for communication 

purpose. The requirements about the usage of CubeSat kit and Arduino boards are extracted 

from the manuals, data sheets and these provide a theoretical body of knowledge. The related 

information is specified in chapter 5. The remaining work for answering the research 

questions 2 and 3 is carried out using the qualitative approach described in the next section. 

 

2.2 Qualitative Research 
 

Qualitative research methods are commonly used within the field of information science. 

Observation, case studies, surveys and documentary analysis are the main methods employed 

in qualitative research. These methods are primarily not concerned on the explanation 

produced but depend on increasing understanding of considerable area. Documents, which 

are the useful source of data in qualitative research, are to be treated with care. In qualitative 

research, data collection and analysis frequently takes place at the same time. The most 
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widely used are journals, official documents, personal documents, questionnaires, files and 

statistics, textbooks.  

 

The purpose of this literature review is to study about the OBDH subsystem of CubeSat and 

also to find the overall requirements for installing the Robot Operating System on the OBDH 

subsystem of a CubeSat. The basic requirements for installing an operating system and real 

time operating system on any embedded platform are analyzed. The Salvo RTOS installed in 

the CubeSat kit and its features are studied. A study on how to implement ROS on different 

hardware platforms is performed. The different features of CubeSat and Robot are studied 

and compared according to the work done in the experimentation, for answering the research 

question 2. The different ways in which the microcontrollers can be communicated is studied 

and the I2C is chosen for efficient communication. Later, an Experiment is conducted to 

communicate the CubeSat kit with Arduino to answer the third question where the open 

source Arduino boards are used for communicating with the CubeSat using an I2C. First, the 

two Arduino boards are communicated using I2C and then the CubeSat kit is used for 

communication with Arduino.  
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3 BACKGROUND 

This chapter describes the necessary background required for the thesis which include the 

classification of Satellites, the CubeSat standard, OBDH, Arduino and ROS. 

 

3.1 The Beginning of Artificial Satellites 

The man made satellite (artificial satellite) which is placed in the orbit is designed for a 

specific purpose. The beginning of the satellites was started in the year October 1957, with a 

mass of 184 pounds it was named “Sputnik 1” launched by the Soviet Union. It was using a 

primary battery so it has re-entered the atmosphere in January, 1958 [5]. After that day, 

many satellites have been sent which are used for communication, weather forecasting, etc. 

The current trend in satellite development is again a preference for smaller satellites. With 

cheaper costs, a wider array of small organizations, academic institutions and industries will 

be able to utilize satellites to a large extent and more advantageous potential.  

 

3.2 Satellite Classification 

The satellite can be classified in many types i.e., they can be classified by their mission, 

purpose, physical property etc. In our master thesis, we are mainly focused on the physical 

properties such as mass, size, diameter etc. of the satellite. The table 3.1 taken from [15] 

shows the classification of the satellite with respect to the mass. In [6], it is illustrated that 

each satellite includes many subsystems and each subsystem has a role to play aboard the 

satellite. In practice, in the field of the satellites design, each satellite subsystem, which 

has dedicated hardware and software, is assigned to one team of experts because each 

satellite subsystem belongs to one branch of science [15].  

 
Table 3.1 Classification of Satellites based on Mass  

 

 

Satellite Class 

 

Examples 

 

Mass 

 

Large Satellite  TRMM, Hubble Space 

Telescope  

>1000 kg  

Minisatellite  IRIDIUM Satellites, GIOVE-A  100 – 1000 kg  

Microsatellite  Sputnik-1, Cerise  10 – 100 kg  

Nanosatellite  Vanguard-1, SNAP-1  1 – 10 kg  

Picosatellite  CubeSat  0.1 – 1 kg 

Femtosatellite  Satellite-on-a-chip  1 – 100 g  

 

There are different ISIS CubeSat structures available which are developed as a generic, 

modular satellite structure based upon the CubeSat standard. In [50], it is explained that the 

building up of flight modules and stack of PCBs is first done in the secondary structure and 

then is integrated with the load carrying frames at the end of the process, ensuring 

accessibility of the flight avionics. The features taken from [50] are: 

 
 Highly modular design 

 Detachable side panels for maximum accessibility 

 Multiple PCB sizes supported 

 Dual Kill-switch mechanism 

 Scalable design to larger CubeSat form factors 
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Table 3.2 Different ISIS CubeSat structures with maximum supported mass 
 

 

CubeSat 

Structure 

 

Part 

production 

tolerances 

(mm) 

 

Maximum 

supported 

mass (total in 

gram) 

 

Primary 

Structure 

Mass 

(gram) 

 

Primary + 

Secondary 

Structure 

Mass 

(gram) 

1-Unit 0.1  2000  100  200  

1.5-Unit 0.1  3000  150  300  

2-Unit 0.1 4000 200 390 

3-Unit 0.1 6000 300 580 

4-Unit 0.1 8000 - 770 

5-Unit 0.1 10000 - 960 

6-Unit 0.1 12000 - 1160 

 

 

3.3 The CubeSat Standard 

The CubeSat standard started as a joint project between Cal Poly State University and 

Stanford University in 1999 [16]. The CubeSat standard allows for many cost effective 

satellite applications which are standardized to a size of 10 cm cube and weight less than 

1.33 kg. The current trend in satellites to do more for less cost described in [22] has led to 

the “Smaller, Cheaper, Faster, Better” space missions. Having small size and weight, as well 

as a standard launching apparatus that can be attached to virtually any spacecraft, CubeSats 

can be put into orbit frequently and cheaply. The figure 3.1 taken from [31] shows the 

CubeSat. 

 

 

 

 

 

 

 

 

                                              

 

 

 

 

Figure 3.1 CubeSat  
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The field of CubeSats is a very fast changing subject with improvements being made on a 

regular basis as observed in the annual CubeSat conference organized by California 

Polytechnic State University and Stanford University in US [54]. [15] Describes the main 

idea of designing the CubeSats as using them as test beds for research in space technology 

with reduced costs, development time and minimized risks. 

 

The CubeSat program offers launch opportunities to universities that, otherwise, would be 

unable to have access to space. The power system is used for the functioning of 

microcontroller and communication by providing necessary power which also reduces the 

weight and volume of the CubeSat. The simulation of the transceiver subsystem restricts 

some requirements and specifications, but encourages the future designers in acquiring some 

knowledge. The individual components of particular CubeSats, for the most part, have not 

been interchangeable despite dozens of independent development efforts. The idea of 

extending space plug-and-play avionics into CubeSats taken from [46] seems to be an 

attractive proposition, since the interchangeability of components between disparate CubeSat 

developments would likely result in significant economies in effort and reductions in the 

time necessary to create CubeSats. In [46], it is illustrated that the CubeSats are constructed 

painstakingly like their large counterparts (i.e., traditional spacecraft) and are among the 

simplest class of space vehicles.  

 

For the technology validation, [24] describes the CubeSats as scalable units which allow 

smaller or larger vehicles to be developed using the specific resource requirements of the 

technology, ensuring that the platform is simple and cost effective. The formulation of the 

CubeSat concept has considerably lowered the entry barrier for countries or organizations 

that wish to become space capable. However, despite the small size, building of a CubeSat is 

a complex task that requires a set of very diverse skills and resources as explained in [20]. 

There are around 60 universities and institutions taking part in the CubeSat program helping 

the students in developing their aptitudes and experience in the field of aerospace 

engineering. In practice, in the field of the satellites design, each satellite subsystem, which 

has dedicated hardware and software, is assigned to one team of experts because each 

satellite subsystem belongs to one particular branch of science as illustrated in [1].  

 

3.4 Onboard Data Handling 

Each satellite includes many subsystems; each subsystem has a role to play aboard the 

satellite [1]. The Onboard Data Handling (OBDH) system is the main subsystem of a 

CubeSat which provides all the functionality and interfaces necessary to support the 

operations of a CubeSat. The Onboard Data Handling Subsystem is the „brain‟ of the whole 

CubeSat. For any OBDH, microcontrollers are considered to be the heart. For providing 

various operation sequences, the OBDH subsystem of the CubeSat needs to be efficient, 

small, lightweight and easy to integrate with other systems. The communication subsystem 

of a CubeSat is of equal importance as that of the ground station which has to send various 

information and data down to the ground station and vice versa. There are several constraints 

to be considered in designing the CubeSat communication subsystem additional to that of the 

ground station. The OBDH subsystem of the CubeSat performs several tasks like controlling 

the different subsystems, communicating with the ground station, storing data and software 

in particular allocated memories, managing and detecting the faults, checking data uplink 

and downlink features by providing efficient programming as explained in [13]. All 

spacecraft functionality including communication between the satellite and ground station, 

navigation and telemetry, housekeeping, etc. is controlled by the OBDH using the flight 

software.  
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3.5 Arduino 

Arduino is an open-source physical computing platform based on a simple microcontroller 

board, and a development environment for writing software for the board [28]. The widely 

popular platform used in the applications in the microcontroller market is an Arduino having 

an overall board size of 10cm x 10cm x 30mm. The Arduino programming language is an 

implementation of wiring based on the processing multimedia programming environment. 

There are different types of Arduino boards available and they can be chosen based on our 

requirement. The Arduino‟s open-source IDE can be downloaded for free and can be used 

for writing and uploading programs to Arduino I/O boards [28]. The Arduino projects are 

stand-alone and the software incorporates various code examples from diverse open sources. 

The advantages of Arduino over the other microcontroller systems taken from [28] are: 

 Arduino boards are inexpensive.  

 The Arduino integrated development environment (IDE) is available for Windows, 

OS X, and Linux systems.  

 The Arduino programming environment is clear, simple and easy-to-use for all the 

users.  

 The Arduino software is available as open source tools which can be extended by 

other experienced programmers.  

 The Arduino is based on Atmel's ATMEGA8 and ATMEGA16 microcontrollers. 

  

The use of Arduino‟s in many engineering projects and research is considerably increased 

due to its low cost and ease of accessibility.  

 

3.6 Robot Operating System 

Robot Operating System (ROS) is designed to promote code sharing and reusability by 

creating and releasing a set of mature and stable software stacks for a faster progress in 

robotics community. In 2007 the ROS concept is developed by Stanford Artificial 

Intelligence as switchyard and was continued by Willow Garage to enable code reuse in 

robotics research and development. ROS is not an operating system in the traditional sense 

of process management and scheduling; rather, it provides a structured communication layer 

above the host operating systems of a heterogeneous compute cluster [9]. [42] Describes the 

main goal of the Robot Operating System (ROS) as enabling the researchers and developers 

around the world to share the code and contribute to the growth of ROS. The Robot 

Operating System (ROS) has risen as a standard and open-source operating system for real-

time embedded and research projects in the past few years. The lack of architecture in ROS 

libraries makes them much easier to integrate into other platforms and also makes it easy to 

integrate code from other platforms (e.g., OpenRAVE, Player, OROCOS) into ROS [12]. 

From [4], ROS provides hardware abstraction, low-level device control, inter-process 

communication API and package management.  

 

I2C is a multi-master communication protocol that is used for data communication between 

any two I2C devices, over two wires. The concept of master and slave devices is defined by 

theI2C protocol and the I2C supports slave acknowledgment, providing that it is being 

communicated with some device. Serial Peripheral Interface is a single-master 

communication protocol where there is no acknowledgment about any data being 

transferred.    
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4  THEORETICAL WORK 

In this chapter, a detailed literature review is performed on RTOS, Salvo RTOS and ROS.  

 

4.1 Literature Review 

The literature review plays an important role in finding the existing research, what the 

current state of art is and what other researchers says about any specific topic. Our main 

focus was in finding research papers, articles, books and websites related to our research 

area.  To know the answers of our research questions, a deep literature review has been done 

with the existing materials. For finding the information related to our research, different 

search engines like Google, Engineering Village, IEEE Explore, BTH Library, Scopus, 

Sciencedirect and Springerlink are used. Many websites related to the manufacturers of the 

boards that are used in our thesis are visited often to get more and more information on the 

specifications. A literature review process helps in understand the functionalities of the 

system in detail. The datasheets of the microcontrollers used in the CubeSat kit and Arduino 

boards are specifically studied to know the power supply requirements required for particular 

boards, since they are very sensitive to the voltage supply.   

 

4.1.1 Real Time Operating System 

Operating System (OS) is a system program that provides an interface between hardware and 

application programs. The main features of an operating system include multitasking, 

synchronization, interrupt and event handling, input/output, inter-task communication, timers 

and clocks and memory management. These features play an important role in managing the 

hardware resources that meet the demands of application programs. “Real-Time Operating 

System (RTOS) is a multitasking operating system intended for real-time applications.” 

RTOS comprises of two components, namely, “Real-Time” and “Operating System” where 

Real-Time indicates the response or reaction for an event on its existence as explained in 

[27].  

 
The advent of microprocessors has opened up several product opportunities that have 

embedded themselves into all fields of our lives. As the complexities of the real-time 

embedded applications increases, benefits of employing a real-time operating system 

(RTOS) becomes ever more oblivious by making it the key to many embedded systems 

today [27]. There are many RTOS‟s available today for the developers of embedded systems 

like RTOS for robotics and RTOS for home appliances. RTOS is therefore an operating 

system that supports real-time embedded systems by providing correct result, defining its 

deterministic timing behavior and limited resource utilization nature. RTOS is effectively 

designed and expanded easily meeting the performances required by the system. 

 

RTOS are generally designed for hard real time RTOS, firm real time RTOS and soft real 

time RTOS. They are also further classified according to the types of hardware devices (e.g. 

8-bit, 16-bit, 32-bit MPU) supported. The main features of RTOS are multitasking, task 

priority, reliable and control of memory management. 

 

RTOS Architecture: 

The RTOS architecture is based on the complexity of its deployment and good RTOS used 

for different applications are scalable to meet different sets of requirements. The selection 

criteria of RTOS can be broadly classified into two main areas; technical features of RTOS 

like scalability, portability, run-time facilities, run-time performance and development tool 

and commercial aspect of the implementation are costs, license and supplier stability [27]. 

Simple RTOS applications usually comprise only a kernel. For complex embedded systems, 
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an RTOS can be a combination of various modules, including the kernel, networking 

protocol stacks, and other components as illustrated in figure 4.1 [27]. 

 

 

                        

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.1 General Architecture of RTOS  

 

4.1.2 Salvo RTOS 

Salvo RTOS is designed to work in compact place where there are several limitations in 

memory. It was specially aimed at less space environment like microcontrollers and 

microprocessors. Salvo 2.0 was developed in ANSI C and assembly language for a task 

specific extension for Pumpkin Cooperation with priority-based multitasking [33]. Salvo 

provides basic multi-tasking kernel that supports sixteen separate task priority levels, the task 

that are with same priority level are executed in round-robin format. There are many 

functionalities that a salvo RTOS can provide in a real time operation that are described in 

[25]. They are: 

 Intertask communication 

 Interrupt control 

 Task scheduling 

 Handles real-time delays 

 Access to shared resources 

 

C language is used to develop application and these applications are developed with specific 

rules that are: 

 Every task must contain at least one context switch 

 Context switch may only occur in tasks [26] 

Salvo does not use stack but still provides high performance real time operating platform 

with efficient footprint, power consumption and memory utilization. 
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4.1.3 Robot Operating System 

In the past few years, the Robot Operating System (ROS) has emerged as a standard and 

open-source operating system for robot control as described in [3]. ROS is not an operating 

system in the traditional sense of process management and scheduling; rather, it provides a 

structured communication layer above the host operating systems of a heterogeneous 

compute cluster [9]. The software mentioned in [15] does not use an operating system to 

interact with each of the subsystems; instead C and assembly language are used for direct 

system control. Most flight software is developed to work on a RTOS. Flight software 

designed to use an RTOS is specific to the RTOS and specific hardware of a specific 

spacecraft, so reusing the software for other missions may be complicated and time 

consuming [8][10]. The complexity faced by reusing software with just one additional 

module is described in [11]. The system described uses a Linux based software framework as 

an operating system (OS) for flight software, providing the advantages of using an OS which 

supports developing additional modules that can be easily implemented and integrated. 

 

ROS provides operating system like service for robots. It is a meta-operating system which 

loads on top of an operating system to provide a standardized set of software framework and 

APIs. ROS is an open source platform that aims to capture the future of robotics. These 

facilities cannot only help robots but also other embedded systems. So, supporting many 

processors is a requirement. Robotics is a challenging systems integration problem and 

requires a rich set of tools to successfully manage the complexity [35]. The robot operating 

system software is licensed under BSD license and some of its included components are 

licensed under various GNU license. ROS does basic things that allow more advanced 

robotics quicker. So the main idea is not to spend lot of time in producing base platform 

anymore because someone had spent years to design motor platform as finely as possible so 

it‟s not necessary to do that anymore.  

 

The main idea is to create sharing platform between universities, hobbyists and industries 

that collaborate together to produce better robotics, higher end robotics and high end 

thinking. Years passed but the collaboration doesn‟t exit and we keep repeating the cycle. 

So, to stop that cycle, ROS was designed to move forward in robotics by having base 

platforms. Robotics contains several processes running on more than one physical 

component so for data exchange ROS provides an Inter-process communication (IPC). ROS 

provides tools and libraries for building, writing, and running code across multiple 

computers [38].        

     

Design Goals of ROS: 

There are many robotic frameworks such as player, yarp, Orocos, carmen, orca and 

Microsoft Robotics studio has some sort of similarities in representing goal with ROS 

framework but ROS mainly focus on code reusability. The primary design goal of ROS is to 

meet a specific set of challenges encountered when developing large-scale service robots 

[37]. ROS goals taken from [48] can be summarized as: 

1. Distributed 

2. Tools-based 

3. Language Independent  

4. Thin 

5. Free and Open-Source  

 

Distributed: 
The distribution that occurs between processes is peer-to-peer communication. In general a 

system built using ROS has many processes possibly on a number of different hosts, 

connected at runtime in a peer-to peer topology that requires a lookup mechanism to allow 

processes to locate each other at runtime [37]. 
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Tools-based: 
For reducing complexity of ROS, the developers have designed a microkernel with a large 

number of small tools to build and run the various ROS components. These tools have its 

own specific tasks like Visualizing the peer-to-peer connection, Navigating the source code 

tree, Graphically plot message data, Set configuration parameters, Measure bandwidth 

utilization and so on. 

 

Language Independent: 
Every coding individual has his own programing language preference and so for distributing 

language preference the ROS is designed to be language-neutral. ROS currently supports 

four very different languages: C++, Python, Octave, and LISP, with other language ports in 

various states of completion [37]. The ROS specification is at the messaging layer making 

Peer-to-peer connection negotiation and configuration occurs in XML-RPC, for which 

reasonable implementations exist in major languages [37]. 

 

Thin: 
The design objective of ROS is to make it as thin as possible so the code developed in ROS 

can be compatible with other robot software frameworks. The compatibility and integration 

of ROS has already achieved in OpenRAVe, Orocos and Player [38].  

 

Free and Open-Source: 
ROS is free and completely open-source. The full source code of ROS is publicly available. 

Its prime goal is to develop an operating system for robotics that should freely available in 

designing application for robots, which allows the development in commercial and non-

commercial projects. The freely available ROS software is licensed under BSD license and 

some of its included components are licensed under various GNU license. 

 

The users of ROS are: 

Industry 

- Willow Garage, Bosch R&D, Vanadium Lab 

Universities 

- MIT, TUM, Stanford, Brown, Berkeley, USC, Rice, CMU, UPenn 

Crazy hobbyists  

 

ROS Platform: 

Supported: currently ROS runs only in Unix-based platforms that to Ubuntu 

- Ubuntu 11.10 to Ubuntu 9.04 

Experimental: 

- OS X (Homebrew), Fedora, Gentoo, OpenSUSE, Debian, Windows 

Partial Functionality: 

- FreeBSD, Android (roscore) [39] 

 

The ROS concepts that are taken from [40] have three levels. They are: 

1) The Computation Graph level 

2) The Filesystem level 

3) The Community level  

 

ROS Computation Graph Level: 

i. Nodes: Nodes are a piece of hardware or processes that perform computation. In 

general a robot system contain many nodes in it each node has its own specific task. 

These nodes are developed from the client library. 

http://www.ros.org/wiki/Nodes
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ii. Messages: The communication between nodes is achieved by passing messages. 

These messages are simple standard primitive types. 

iii. Topics: Topic is the name that is given for the message and then routed via transport 

system. A node that is interested in a certain kind of data will subscribe to the appro-

priate topic. There may be multiple concurrent publishers and subscribers for a 

single topic and a single node may publish and/or subscribe to multiple topics [40]. 

 

 

 

 

 

 

iv. Master: Master is the central coordinator it provides node labeling and searches for 

node participation in building a computation graph. Master plays a prime role in 

processes communication. 

v. Parameter Server: It‟s a part of Master which stores data in central location. 

vi. Services: services talks in two way transport for a faster communication. This is 

described as a pair of message structure one for request and other for response from 

the node. This is how services talk, for e.g., let us consider a sonic sensor talking to 

motor in node communication, so the motor request the sensor where is the obstacle 

and the sensor replies as response for it.  

 

 

 

 

 

 

 

 

vii. Actions: A complete set of communication between action client and action server 

to do a task. This whole messaging technique is explained with an example. 

Consider that a robot has to move five feet distance, so the goal is set with the 

mobility processes these gives the status information of how much distance is 

covered and how much is left out. If the task is down or not is shown in the result the 

whole processes can be canceled any time. Feedback loop is to adjust the task if 

some obstacle is occurred.  

 

 

 

 

 

 

 

 

 

 

http://www.ros.org/wiki/Messages
http://www.ros.org/wiki/Topics
http://www.ros.org/wiki/Master
http://www.ros.org/wiki/Parameter%20Server
http://www.ros.org/wiki/Services
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ROS Filesystem Level: 

The development of ROS is governed by a package system, where one package is not more 

privileged than another and the code is added by creating a new package [44]. The filesystem 

allows developers to organize the code into packages and better handling dependencies [36].  

i. Packages: Packages can contain any-thing: libraries, nodes, message definitions, 

tools, datasets or configuration. Each package should have enough functionality to 

be useful but not so much as to make it heavyweight [35]. 

ii. Stacks: A group of packages form a stack. Stacks provide the overall functionality 

and explain the releases and versions of ROS software. 

iii. Manifests: The data related to license, package dependency, language specificity 

and objectives are provided by manifests. 

iv. Stack Manifests: Stack manifests give information about collaborative stacks that 

can utilize resources and information sharing to complete a task. 

v. Service types: Service types define the various types of services provided by ROS 

like request, response, feedback and status. It defines the request and response data 

structures for services in ROS.   

 

ROS Community Level: 

The ROS Community Level concepts are ROS resources that enable separate communities to 

exchange software and knowledge. These resources mainly include the ROS wiki, ROS 

answers, repositories, distributions, blog and mailing lists.  

 

The main focus of ROS is on mobility, perception and manipulation of robots. For example, 

ROS has resulted in the development of several high level algorithms which concentrate on 

aspects like navigation, localization, planning and powerful data visualization. 

 

 

 

http://www.ros.org/wiki/Packages
http://www.ros.org/wiki/Stacks
http://www.ros.org/wiki/Manifest
http://www.ros.org/wiki/Stack%20Manifest
http://www.ros.org/wiki/srv
http://www.ros.org/wiki/Services
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5 REQUIREMENTS AND CONSTRAINTS 

This chapter describes the hardware and software requirements for the CubeSat project.  

 

5.1 Hardware Components 

The hardware components used in the experiment are CubeSat kit and Arduino boards.  

 

5.1.1 CubeSat Kit 

The CubeSat kit's electronic hardware is designed around Pumpkin's space-proven satellite 

architecture which supports different processors and the Motherboard (MB) implements 

Pumpkin's CubeSat Kit architecture [31]. Pumpkin Inc. provides the highest-quality tools for 

embedded system designers who are active in both software and hardware design. Salvo 

provides RTOS for the CubeSat kit. 

 

The Development Board (DB) has all the features of the motherboard including a variety of 

features that make it suited for laboratory work. The following features taken from [31] are 

included in our DB.  

 

 Two 104-pin CubeSat Kit Bus connectors  

 Inline jumpers for circuit isolation and current measurements 

 The power supply of +5V and +3V  

 A configurable RS-232 serial port with DB-9 connector 

 LED indicators for knowing the power status 

 A reset switch 

 

Many existing CubeSat Kit users wish to implement SPI and I2C communications together 

via the USART0 Peripheral Interface. We use the Pluggable Processor Module (PPM) D1 

Hardware Revision: A board in our thesis. The main features of the PPM are: 

 

 CubeSat Kit Motherboard (MB) 

 16-bit Microchip PIC24FJ256GA110  

 Program memory of 256KB program memory  

 SRAM of 16KB  

 Up to 16MIPS - 32MHz 

 

Integrated peripherals: 

 UARTs - 4, SPIs - 3, I2Cs - 3 

 16-channel 500ksps Analog to Digital Converter 

 16-bit timers - 5 

 9 compare / PWM outputs 

 RTCC, WDT, ICD, JTAG 

 Majority of peripheral pin selects are mapped to PPM connector 

 8 MHz and 32.768 kHz clock crystals 

 PCB - 4-layer gold-plated blue-soldermask     

http://cubesatkit.com/content/space.html
http://cubesatkit.com/docs/datasheet/DS_CSK_MB_710-00484-D.pdf
http://cubesatkit.com/docs/datasheet/DS_CSK_DB_710-00297-D.pdf
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Figure 5.1 CubeSat Kit [31] 

 

USB 2.0: 

The CubeSat kit includes a USB 2.0-compliant USB port that can be used to communicate 

between the CubeSat Kit and any PC running Windows, Mac OS X or Linux.  

 

Multiple Serial Interfaces: 

All CubeSat Kit PPMs provide at least two UARTs, one SPI channel and one I2C channel. 

They are typically utilized as: 

 UART0 is free for using in communication with a payload via RS-232. 

 UART1 is for the transceiver interface. 

 I2C0 is typically used to communicate with I2C devices.  

 PPM D1 has four UARTs, three SPIs and three I2Cs, which leaves at least two 

UARTs, two SPIs and two I2Cs that are completely open for user assignment [31].  

 

RS-232 Port:  

The Development Board provides an RS-232 driver for UART0. 

Applications: 

• CubeSat Nano satellite control, Command and Data Handling 

• General-purpose low-power computing for CubeSat Kit architecture 

• Remote sensing for harsh environments 

 

5.1.2 Arduino UNO 

The Arduino UNO  is a microcontroller  which consists of 14 digital I/O pins of which 6 pins 

are PWM outputs, 6 analog inputs, a 16 MHz crystal oscillator, a USB connection, a power 

jack, an ICSP header, and a reset button [29]. The Uno doesn‟t use the FTDI USB-to-serial 

driver chip. Instead it features the Atmega16U2 programmed as a USB-to-serial converter. 

 

"UNO" means one which is an Italian word and is named to mark the release of Arduino 1.0. 

The Uno and version 1.0 will be the reference versions of Arduino, moving forward. The 

Uno is the latest in a series of USB Arduino boards, and the reference model for the Arduino 

platform [29]. The specifications of Arduino UNO are: 
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Table 5.1 Arduino UNO Specifications 

 

Microcontroller ATmega328 

Operating Voltage 5V 

Input Voltage (recommended) 7-12V 

Input Voltage (limits) 6-20V 

Digital I/O Pins 14  

Analog Input Pins 6 

Flash Memory 32 KB (ATmega328)  

SRAM 2 KB (ATmega328) 

EEPROM 1 KB (ATmega328) 

Clock Speed 16 MHz 

 

 

 

 

 

 

 

 

 

Figure 5.2 Arduino UNO [29] 

 

Power:  

The board consists of everything that is needed to support the microcontroller, which simply 

connects to a computer with a flash or enable a power source with an AC to DC adapter to 

get started [29]. The board is operated on an external supply of 6 to 20 volts, but the 

recommended range is 7 to 12 volts. 

 

The power pins of Arduino UNO taken from [29] are as follows: 

 VIN: The input voltage to the Arduino board when it's using an external power 

source. The voltage is supplied through this pin, or, if supplying voltage via the 

power jack, access it through this pin. 

 5V: This pin outputs a regulated 5V from the regulator on the board. The board can 

be supplied with power from the USB connector (5V), or the VIN pin of the board 

(7-12V).  

 3.3V: A 3.3V supply is generated by the on-board regulator and the maximum 

current drawn is 50 mA. 

 GND: Ground pins. 

 

Memory:  

The ATmega328 has 32 KB and has 2 KB of SRAM and 1 KB of EEPROM. 
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 Input  and Output  pins  taken from [29]  are:  

Each of the 14 digital pins on the Arduino Uno can be used as an input or output operating at 

5V. In addition, some pins have specialized functions: 

 Serial: 0 (RX) and 1 (TX) are used to receive (RX) and transmit (TX) TTL serial 

data.  

 External Interrupts: The pins 2 and 3 can be configured to trigger an interrupt on a 

low value, a rising or falling edge, or a change in value.  

 PWM: The pins 3, 5, 6, 9, 10, and 11 on the board provide 8-bit PWM output. 

 SPI: The pins 10, 11, 12 and 13 support SPI communication using the SPI library. 

 LED: A built-in LED is connected to digital pin 13. The LED is on when the pin is 

HIGH in value and it‟s off when the pin is LOW. 

 

The Arduino Uno has 6 analog inputs labeled A0 through A5. Some pins in addition 

have specialized functionality: 

 TWI: A4 or SDA pin and A5 or SCL pin which support TWI communication.  

There are a couple of other pins on the board: 

 AREF: This is the reference voltage for the analog inputs.  

 Reset: To reset the microcontroller, we should bring this line LOW.  

 

Communicat ion:  

The Arduino Uno has a number of facilities for communicating with a computer, another 

Arduino or other microcontrollers. The ATmega328 supports I2C (TWI) and SPI communic

ation providing UART TTL (5V) serial communication allowed by using SoftwareSerial 

library, which is available on digital pins 0 (RX) and 1 (TX) [29].  

 

5.1.3 Arduino Diecimila 

The Arduino Diecimila is a microcontroller board based on the ATmega168 having 14 

digital input/output pins, 6 analog inputs, a 16 MHz crystal oscillator, a USB connection, a 

power jack, an ICSP header and a reset button. It contains everything that is needed to 

support the microcontroller. It can be simply connected to a computer with a USB cable or 

power it with a AC-to-DC adapter to get started.  

 

"Diecimila" is an Italian word which means 10,000. It was named so as to mark the fact that 

over 10,000 Arduino boards had been made. The Diecimila is the latest USB Arduino board 

having the specifications as: 

 

Table 5.2 Arduino Diecimila Specifications 

 

Microcontroller ATmega168 

Operating Voltage 5V 

Input Voltage (recommended) 7-12 V 

Input Voltage (limits) 6-20 V 

Digital I/O Pins 14  

Analog Input Pins 6 

Flash Memory 16 KB  
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SRAM 1 KB 

EEPROM 512 bytes 

Clock Speed 16 MHz  

 

Figure 5.3 Arduino Diecimila [30] 

 

Power:  

The Arduino Diecimila can be powered via a USB connection or with an external power 

supply. External power other than from USB can come either from an AC-to-DC adapter. 

The board operates on an external supply voltage of 6 to 20V, but the recommended range is 

between 7 and 12 volts. 

 

The power pins of Arduino Diecimila taken from [30] are as follows: 

 VIN: It is the input voltage to the Arduino board when it's using an external power 

source. The voltage to the Arduino can be supplied through this pin.  

 5V: This is regulated power supply used to power the microcontroller and other 

components on the board which can come either from VIN via an on-board 

regulator, or be supplied by USB or another regulated 5V supply. 

 

 3.3V: A 3.3V supply is generated by the on-board FTDI chip and the maximum 

current drawn is 50 mA. 

 GND: Ground pins. 

 

Memory:  

The ATmega168 has 16KB of flash memory for storing code and has 1 KB of SRAM and 

512 bytes of EEPROM. 

 

Input  and Output  pins  are:  

Each of the 14 digital pins on the Diecimila can be used as an input or output which operates 

at 5 volts. 
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Communication:  

The Arduino Diecimila has a number of facilities for communicating with a computer, 

another Arduino, or other microcontrollers. The ATmega168 provides UART TTL (5V) 

serial communication, which is available on digital pins 0 (RX) and 1 (TX). 

The ATmega168 also supports I2C (TWI) and SPI communication and a Wire library is 

present which simplifies the use of the I2C bus. I2C is a low-bandwidth, short distance 

protocol for on board communications where all the devices are connected through two 

wires: serial data (SDA) and serial clock (SCL) [30]. 

 

5.1.4 Computer Specifications 
 

The minimum requirements for conducting the experiment are: 

 

 A computer is needed for the purpose of communication between CubeSat kit and 

Arduino boards having the following. 

 1 GHz processor or faster processor 

 512 Mb RAM 

 40 GB Hard Disk Drive 

 Keyboard, Mouse 

 Connecting wires for communication 

 

5.2 Software Components 
The software components used in the experiment are MPLAB ICD 3, Arduino IDE, 

Windows 7 operating system and Ubuntu 10.04 operating system. 

 

5.2.1 MPLAB ICD 3 
MPLAB ICD 3 In-Circuit Debugger System is Microchip's most cost effective high-speed 

hardware debugger/programmer for Microchip Flash Digital Signal Controller (DSC) and 

microcontroller (MCU) devices [32]. The debugger system will execute code like an actual 

device because it uses a device with built-in emulation circuitry, instead of a special 

debugger chip, for emulation [36].It debugs and programs PIC Flash microcontrollers and 

dsPIC DSCs with the powerful, yet easy-to-use graphical user interface of MPLAB 

Integrated Development Environment (IDE) and the Debugger probe is connected to the PC 

using a high-speed USB 2.0 interface and is connected to the target [32]. MPLAB ICD 3 has 

improved speed and supports all Emulation headers as compared with MPLAB ICD 2. 
 

 

 
 

 

 

 

 

 

 

 

 

Figure 5.4 MPLAB ICD 3 
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Features: 

 Real-time Debugging: MPLAB ICD 3 In-Circuit debugger is designed for 

supporting high-speed processors running at maximum speeds to debug applications 

in real time. 

 Ruggedized Probe Interface: The probe drivers are added with some protection 

circuitries in order to protect the kit from the target power waves.  

 Microchip Standard Connectivity: It employs a standard microchip debugging 

connector (RJ-11). 

 Portable, USB-powered and RoHS-Compliant: Housed in a small (3.7" x.8") and 

attractive enclosure, the MPLAB ICD 3 In-Circuit debugger is powered by the USB 

port, so an external power adapter is not required [32].  

 High Speed Programming: Fast programming allows both quick firmware reload 

for fast debugging and for in-circuit re-programming. Programming times are 

improved up to 15x over MPLAB ICD 2 [32]. 

 Low Voltage Emulation: It supports target supply voltages from 2.0 to 5.5 volts. 

 Test Interface Module: It is used to test I/O lines and confirm the unit is working 

properly. 

 Ease of Maintenance and Feature Upgrade: Adding new device support and 

advanced features is simple and can be field upgraded through a firmware. 

  Low Cost: It breaks the price barrier to interact with and debug applications at a 

fraction of the cost of traditional emulator systems. 

 

Installation procedures of MPLAB ICD 3 in-circuit debugger from [36] are:  

 Installing the Software: To install the software, we need to acquire the MPLAB 

IDE installation executable (MPxxxxx.exe) from either the microchip web site or the 

MPLAB IDE CD-ROM given during the purchase. We have used MPLAB IDE 

v8.76. 

 Installing the USB Device Drivers: The USB device drivers for the MPLAB ICD 3 

in-circuit debugger are preinstalled by MPLAB IDE. 

Connecting the Target:   
This is done by pluging in the USB/power cable and the communication cable is 

needed to be attached between debugger and target. 

 Setting up the Target Board: The target must be set up for the type of target device 

to be used.  

 Setting up MPLAB IDE: Once the hardware is connected and powered, MPLAB 

IDE may be set up for use with the MPLAB ICD 3 in-circuit debugger [36].  

 Starting the MPLAB IDE Software: After installing the MPLAB IDE software, 

invoke it by using any of these methods:  

Select Start>Programs>Microchip>MPLAB IDE vx.xx>MPLAB IDE, where vx.xx 

is the version number [36]. 

• Double click the MPLAB IDE desktop icon. 

• Execute the file mplab.exe in the \core subdirectory of the MPLAB IDE 

installation directory. 

 Creating a Project: The easiest way to create a new project is to select Project> 

Project Wizard, a new project and the language tools for building that project can be 

created [36]. The wizard will guide the process of adding source files, libraries, 

linker scripts, etc., to the various “nodes” on the project window. The basic steps in 

[36] are provided here: 

• Select the device (PIC24FJ256GA110) 

• Select a language tool suite  

• Name the project 

• Add application files (e.g., program.c, support.s, counter.asm) 
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 Viewing the Project: After creating a project, the project and its associated files are 

visible in the Project window where we can add or remove extra files. Right click on 

any line in the project window tree to pop up a menu with additional options for 

adding and removing files. 

 Building the Project: Once the project is created, the application needs to be built, 

which will create object (hex) code for the application that can be programmed into 

the target by the MPLAB ICD 3 in-circuit debugger [36]. To set build options, select 

Project>Build Options>Project. 

 Setting Configuration Bits: The device Configuration bits may be set in the 

MPLAB IDE Configuration window choosing Select Configure>Configuration Bits. 

 Setting the Debugger as the Debugger or Programmer [36]: Select 

Debugger>Select Tool>MPLAB ICD 3 to choose the MPLAB ICD 3 in-circuit 

debugger as the debug tool, the Debugger menu and MPLAB IDE toolbar will 

change to display debug options once the tool is selected. The Output window will 

open and messages concerning MPLAB ICD 3 status and communications will be 

displayed on the MPLAB ICD 3 tab. Select Programmer>Select 

Programmer>MPLAB ICD 3 to choose the MPLAB ICD 3 in-circuit debugger as 

the programmer tool, the Programmer menu and MPLAB IDE toolbar will change to 

display programmer options once the tool is selected. The Output window will open 

and messages concerning ICE status and communications will be displayed on the 

MPLAB ICD 3 tab [36].  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.5 Selecting MPLAB ICD 3 as the Programmer tool 

 

5.2.2 Arduino 
The Arduino software includes a Wire library to simplify use of the I2C bus and for SPI 

communication we use the SPI library. The Arduino software includes a serial monitor 

which allows simple textual data to be sent to and from the Arduino board [34]. The RX and 

TX LEDs on the board will flash when data is being transmitted via the USB-to-serial chip 

and USB connection to the computer, via the FTDI chip and USB connection to the 

computer [28]. We need to get an Arduino board and USB cable, download the Arduino 

environment and use accordingly.  
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Figure 5.6 Arduino and USB cable [28] 
 

Connect the board: 

 The Arduino UNO automatically draws power from either the USB connection to 

the computer or an external power supply [34]. 

 If you're using an Arduino Diecimila, ensure that the board is configured to draw 

power from the USB connection. 

 Connect the Arduino board to your computer using the USB cable. The green power 

LED should go on. 

 

Installing the Arduino drivers taken from [34]: 

Installing drivers for the Arduino© UNO with Windows7 [34]: 

 Plug in the board and wait for Windows to begin it's driver installation process 

 Click on the Start Menu, and open up the Control Panel. 

 In the control panel, we need to navigate to system and security. Next, click on 

system. Once the system window is up, open the device manager. 

 Look under Ports (COM & LPT).  We should see an open port named "Arduino 

UNO (COMxx)" 

 Right click on the "Arduino UNO (COmxx)" port and choose the "Update Driver 

Software" option. 

 Next, choose the "Browse my computer for driver software" option. 

 Finally, we navigate to and select the Uno's driver file, named "ArduinoUNO.inf", 

located in the "Drivers" folder of the Arduino Software download. 

 Windows will finish up the driver installation. 

 

Launch the Arduino application: 

 Double-click the Arduino application. 

 

Open the example: 

 After opening the application, open the required file. 

 

Select your board: 

In this step, the type of Arduino Board we are using is selected. 

 Go to Tools>Board> Arduino Uno (for Arduino Uno). 

 Go to Tools> Board: Arduino Diecimila (for Arduino Diecimila). 
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Figure 5.7 Selecting the Arduino Board (Diecimila) 

 

Select your serial port: 

 The serial device of the Arduino board is selected from the Tools, Serial Port menu. 

 This will be COM3 or higher. 

 The serial device is found by disconnecting Arduino board and by reopening the 

menu; the entry that disappears should be the Arduino board. 

 Reconnect the board and select that serial port. 

 

Upload the program: 

 Now, click the "Upload" button in the environment and wait a few seconds, we 

notice that the RX and TX leds on the board flashing.  

 If the upload is successful, the message "Done uploading" will appear in the status 

bar and a few seconds after the upload finishes, we see the pin 13, LED on the board 

starts blinking (in orange). 

 When the light starts blinking, that means the Arduino is started. 
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6 EXPERIMENTATION  

Our goal is to simulate transceiver and power supply subsystem‟s using Arduino UNO and 

Arduino Diecimila for communication with CubeSat kit. In developing this, firstly we had 

tried to get the communication between two Arduino‟s. Finally, an attempt has been made to 

communicate between the CubeSat kit and Arduino for getting the simulated subsystems.  

 

The components used in our experimental setup are CubeSat kit, Arduino UNO, Arduino 

Diecimila, computer with Windows 7 operating system, connecting wires and Resistors (1.5 

and 2.2 KΩ). The Arduino UNO is simulated as the transceiver and the Arduino Diecimila is 

simulated as the power supply for the CubeSat. I2C (Inter-Integrated Circuit) is used for 

communication between the two Arduino‟s and between CubeSat kit and Arduino‟s. I2C is 

supported by many devices and is used for moving data simply and quickly from one device 

to another.  

Figure 6.1 Experimental Setup 

 

I2C is a popular synchronous protocol that allows a master device to initiate communication 

with a slave device simply and quickly. The connection details are shown below:  

 

1. To run the CubeSat, a power supply of 5V is needed; this is given from the Arduino 

UNO acting as the power supply subsystem for the CubeSat. 

2. The Arduino Diecimila acts as a transceiver subsystem of the CubeSat that will 

communicate with the Personal Computer (PC) in transmitting and receiving the 

data.  

3. The Arduino is connected to the PC (Personal Computer) using the USB cable and it 

is also able to communicate with the PC using the Arduino IDE. 

4. First, the two Arduino‟s are communicated. The first Arduino acts as the master and 

the second acts as the slave device. In this communication, only one Arduino is 

given the power supply and the second Arduino gets the power from the first 

Arduino when connected.  

5. The following communication between the Arduino‟s is successful: 

 Arduino UNO as master and Arduino Diecimila as slave  
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 Arduino UNO as slave and Arduino Diecimila as master  

6. A baud rate of 9600 is kept constant for communication between Arduino and 

CubeSat, Arduino and Arduino. 

 

 

 

 

 

 

 

 

 

 

 

           Figure 6.2 Communication between Arduino UNO and Diecimila 

 

7. The CubeSat kit is able to communicate with the PC using the MPLAB ICD 3. 

8. The CubeSat kit is able to receive the power supply from the Arduino UNO but it is 

not able to transmit and receive the data from Arduino Diecimila. 

9. The different ways in which the communication between CubeSat kit and Arduino 

are done is: 

 Firstly, the CubeSat kit PIC is made as a master and the Arduino as a slave.  

 Next we tried to communicate using Arduino as a slave and PIC as master. 

 This process was carried out for different resistor values. 

 We have verified these with the different codes provided by the Pumpkin,  

     Microchip, Arduino and had taken guidance from forum. 

 A special care is taken for providing address for the devices as the PIC  

    generally takes the hexadecimal format and Arduino takes deciamal format. 

 Also, the two clock frequencies 100 KHz and 400 KHz were used in the  

    attempt to establish communication between CubeSat kit and Arduino.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

       
Figure 6.3 Communication between CubeSat kit and Arduino 
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This is a unique project in which the communication between CubeSat kit and Arduinos is 

performed with the installation of ROS in OBDH. In all the cases, we have tried to 

communicate using baud rate of 9600. The master and slave code for both the 

communications are different. The master and slave device addresses plays an important role 

in communication with each other. If the communication was successful, it would have been 

very useful to many institutions, small and large organizations in field of CubeSat research, 

as the cost decreases by a very huge amount.     
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7 RESULTS AND ANALYSIS  

1) Can  the  ROS  provide  a  foundation  for  the  Onboard  Data  Handling  (OBDH) 

subsystem of a CubeSat? 

 

Result: 
From the extensive literature review that was performed to understand ROS and its 

application in robotics, it can be clearly stated that, under the current circumstances where 

ROS is still in the process of complete development and is evolving itself to adapt to 

different technical needs and requirements, it cannot provide a total foundation for OBDH 

subsystem in a CubeSat. The following points provide a comprehensive justification to our 

answer. 

 

1. Lack of real time framework: 

i. ROS is a meta-operating system which loads on top of an operating system to 

provide a standardized set of software framework. This causes a huge hindrance in 

choosing ROS for real time purposes because; first the system has to run Linux and 

then ROS on it. Thus, ROS cannot handle real time issues. 

ii. Although ROS is not a real time framework, it is possible to integrate ROS with real 

time but not under the present constrained scenario where CubeSat is provided with 

a default hard real time running embedded system. The ROS software stack is built 

on general purpose operating systems like Linux and Mac OS which makes it 

difficult to run ROS with real-time support.  

 

2. Insufficient memory size: 

i. CubeSat contains PIC24FJ256GB110 which is a 16 bit microcontroller with a 

program memory of 256 kb and a RAM of 16 Kb. Under such minute memory 

constraints, ROS cannot be run on a CubeSat.   

ii. The lowest hardware which supports ROS is gumstix which has a memory of 512 

Mb. 

 

3. Platform dependent: 

i. ROS is mainly supported on Linux platform and all its modules are developed in 

Ubuntu. 

ii. The CubeSat developed by pumpkin is compatible with linux systems like Ubuntu 

but the MPLAB IDE 3 debugger for PIC24 is not compatible with linux which 

restricts the use of ROS in CubeSat. 

   

Analysis:  

ROS has been successfully implemented in Robotics. The inability of ROS to provide a real 

time framework has been rectified with pr2_etherCAT which is a system used in Willow 

Garage PR2 robot. This system transports ROS messages in and out of a real-time process. 

ROS also has seamless integration with the Orocos Real-time Toolkit [38]. Real time tool 

kits like Orocos when developed for CubeSats would eliminate the real time problems faced 

by ROS. This would result in successfully using ROS for CubeSats to provide a foundation 

for OBDH subsystems. The use of RGMP is also helpful for implementing ROS to achieve 

real-time goals [43]. 

 

Platform dependency of ROS and memory restrictions can be overcome by using 

uclinux based Linux 2.0 kernal for microcontrollers without memory management. ROS 

provides AVR_bridge for supporting AVR microcontrollers. This results in implementing 

ROS packages in Arduino by using rosserial_arduino package, without having to worry 

about the memory constraints. If an API like an AVR_bridge for CubeSat PIC is developed, 

then it would be possible to run and operate ROS packages in CubeSat. 

http://www.willowgarage.com/blog/2009/06/10/orocos-rtt-and-ros-integrated
http://ros.org/wiki/rosserial_arduino/Tutorials/Arduino%20IDE%20Setup
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2) What are the advantages and disadvantages of ROS in robotics with respect to 

CubeSat? 

 

Result: 

ROS is primarily used in robotics and the option of using ROS in CubeSats should first be 

carefully   analyzed. For such an analysis, the use of ROS in robotics is studied and after a 

broad review of ROS and its use in robotics has prompted the authors to list several of its 

advantages and disadvantages. Features of ROS, their advantages and disadvantages in 

robotics are taken as a base to understand the use of ROS in CubeSats. ROS so far has not 

been implemented in CubeSats, and this study brings forward some of its benefits and 

problems if implemented in CubeSats. 

 

Advantages of ROS in Robots: 

 

ROS 

 

Advantages 

Free & open source Full source code of ROS is publicly available and there are many 

API‟s and tools which are present in more than 2000 libraries. Anyone 

can use these APIs by writing simple packages to their processes. 

  

Robot independent ROS is designed to be independent to the type of robot.  It provides 

libraries and tools to create robot applications regardless of the robot 

being used. There are different categories of robots like Mobile 

Manipulators, Mobile Robots, Autonomous cars, Humanoid, UAV‟s 

etc. all of which can run on ROS. 

Greater flexibility ROS is a distributed framework of processes. Its main purpose is to 

make a framework that is easy to integrate with other robot software 

frameworks.  This was achieved in OpenRAVE, Orocos and Player 

[38]. 

Multi-lingual ROS modules are designed in C++, Python and Lisp. Experimental 

languages like Java and Lua are in development stage. Use of multiple 

languages is an advantage in interacting with different modules of a 

robot. 

Easy testing ROS has a built in test framework called „rostest‟ which makes it easy 

to test and fix the problems [38]. 

Scaling ROS is suitable for large development processes and runtime systems 

[38].  
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Disadvantages of ROS in Robots: 

 

ROS 

 

Disadvantages 

Platform specific Presently ROS only runs in Unix-based platform. It was mainly 

developed and tested on Ubuntu. There are many experimental 

platforms like Windows, Fedora, OS X, Gentoo, Android etc., that 

support some libraries of ROS. 

 

Real-time support ROS does not focus on real-time implementation but it had acquired 

some real time features from Orocos real time tool kit. 

Service oriented ROS is a service oriented control system, it depends on peer to peer 

topology and broad casting signals [45]. 

Time to learn  In learning ROS one should have sufficient knowledge in Linux, C++ 

or Python and robot framework. It takes time for effective 

implementation of ROS.  

Installation process Installation process of ROS is a lengthy, complex and a time 

consuming process.  

 

 

 

Implementation of ROS in robots gives an idea on whether the different features would 

prove advantageous or otherwise with respect to CubeSats. 

 

 

 

ROS 

Feature 

 

CubeSat 

 

 

Advantage 

 

Disadvantage 

 

Not Applicable 

Device 

independen

t 

 

--- 

 

--- 

Device independence 

of ROS doesn‟t have 

an effect on CubeSats 

since there are not 

many types of CubeSat

s available as in the 

case of Robots. 

 

 

Easy 

testing 

Easy testing mechanism

s are very effective in 

detecting the problems. 

 

 

--- 

 

--- 
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Flexibility 

 

 

 

 

--- 

 

 

 

 

--- 

Future ROS versions 

may prove to be 

advantageous for use in 

CubeSat but the 

flexible nature of 

present ROS may not 

have much of an effect 

on its use in CubeSat. 

 

 

Free & 

Open 

Source 

Free and open source 

softwares are always a 

huge advantage to work 

with and use for testing 

in complicated 

embedded systems like 

CubeSat.  

 

 

 

--- 

 

 

--- 

 

 

 

Installation 

process 

 

 

--- 

This is one of the biggest 

disadvantages of ROS in 

CubeSat since ROS is a 

meta operating system 

which must be installed on 

top of Linux. 

 

 

--- 

 

 

Multi-

lingual 

Since the primary focus 

of using ROS in 

CubeSat is on resource 

management and 

scheduling, this feature 

of ROS is an advantage. 

 

 

 

--- 

 

 

--- 

 

 

Platform 

dependent 

 

 

 

--- 

The debugger used to write 

the code for PIC24 in 

CubeSat is used on 

Windows platform 

whereas the current form 

of ROS is designed to 

work on Linux. 

 

 

 

 

--- 

 

 

 

Real-time 

support 

 

 

 

--- 

 

CubeSat requires complete 

hard real- time support. 

Current ROS version does 

not provide real time 

support and the ROS 

integration with Orocos is 

still in development stages. 

 

 

 

 

--- 

 

 

 

Scalability 

CubeSats are miniature- 

zed satellites having spe

cific dimensions for 

specific structures 

making them scalable. 

 

 

--- 

 

 

--- 
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Service 

Oriented 

 

 

--- 

 

Inter processor communica

tion is necessary in 

CubeSat. All its communic

ations are from a centralize

d microcontroller. 

 

 

--- 

 

 

Time to 

learn 

 

 

 

--- 

Linux and other 

programing languages are 

important for CubeSat 

developers but learning 

new domains like robot 

framework is a time 

consuming process. 

 

 

 

--- 

 

Analysis: 

ROS so far has not been implemented in CubeSats and this study brings some of its merits 

and demerits for implementation in CubeSats. The analysis is done by taking the advantages 

and disadvantages of ROS in Robots that are considered for comparative study in CubeSats.  

 

From the study, the CubeSat has advantages with ROS features like free and open source, 

multi-lingual and scalability. The disadvantages of ROS in CubeSat such as platform 

independent, real time support and some of the features are still in developing stages in ROS, 

that might be overcome in future versions. The features like device independent and 

flexibility are not appropriate for one particular CubeSat but these features may be a benefit 

for large systems like NanoSats.  

 

 

3) What are the problems encountered during the communication of the CubeSat kit with 

Arduino? 

 

Result: 

The experimental setup involved designing simulated transceiver and power supply 

subsystems with Arduino board. Several problems (mentioned below) were encountered 

during the development and these problems coupled with the non-availability of protocol 

analyzer resulted in suggesting that transceiver and power subsystems cannot be developed. 

The problems faced during the development are classified as:  

 Common problems 

 Obscure problems 

Common Problems: 

These problems are basic technical/electrical problems which can be overcome by thorough 

inspection and repeated testing. The following common problems were a challenge in the 

process of development. 

 

Problem 

 

Description 

 

Voltage  

 

Correct supply of voltage is to be given for external devices. All the 

external devices were powered correctly with their respective voltages. 
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Selecting resistor To achieve I2C communication, pull up resistors for sending and 

receiving the signal between devices are required. Two types of pull up 

resistors - 1.5 KΩ and 2.2 KΩ were used. 

 

I2C capabilities Arduino and the PIC in Cubsat kit are supported by I2C. They have 

their individual pins for connecting I2C. Arduino pins are 4 and 5,  

CubeSat kit pc104 bus has I2C interface at pins 41 and 43. 

 

Addressing  Some devices contain predefined address values that match with other 

devices resulting in a conflict in I2C connection. In the Arduino IDE, 

addressing is given in numerical formas Ex 42 or as the corresponding 

decimal value. In PIC, the addressing has to be given in hexa decimal 

format, so the slave address 42 is given as 0x2a and 10 is given as 

0x3c. 

 

Frequency  This is an important problem where special care is to be taken in 

selecting the correct frequency between devices. This issue is resolved 

by considering the two clock frequencies that are supported by these 

devices FSCL = 100 kHz and FSCL = 400 kHz. 

 

Baud rate  A baud rate is to be selected that is compatible with both the devices.  

A baud of 9600 is selected. 

 

I2C master support PIC 24 of the CubeSat kit and Arduino are master supporting devices. 

These are confirmed from the datasheet. 

 

Connections  There is a possibility that the connection of SCL may be interchanged 

with that of SDL. This interchange will not result in any output in 

serial monitor of the Arduino IDE. These connections are properly 

checked during the experiment. 

 

Device testing The Arduino boards are tested by using the sample code given in the 

Arduino IDE. CubeSat kit is tested by the test code provided by Salvo. 

 

 

Obscure problems:  

These problems occur in I2C that stop the communication between devices. 

 

Problem 

 

Description 

 

Negative 

acknowledgment 

Negative acknowledgment is a small error condition sent by the slave 

may not be detected by the Master [41]. 

 

Voltage threshold Devices using I2C may find it difficult in recognizing the high and low 

values of SCL and SDL. These cannot be detected by an Oscilloscope 

and more sophiscated equipment is needed in detecting such behaviors.  

PIC24 has a voltage threshold at 5.2 volts and Arudino has a voltage 

threshold at 5.3 volts. 

 



  34 

Sensitive for cross 

talk and noise 

The absence of Schmitt trigger and (or) spike filters in some devices 

results in unnecessary disturbances in the signals caused by crosstalk 

and noise. There is more noise when resistors are not present and the 

signals are too small to respond [41]. 

 

Halt period Sometimes, the signals are discontinued or become idle after some 

time of interaction on the I2C bus. This is caused by an inappropriate 

signaling of SDA or SCL by a sudden restart of the device [41]. 

 

 

Analysis: 

These types of problems are hard to find using an oscilloscope. In [53] it is described that an 

oscilloscope can help, but it is rather limited and does not help to analyze the protocol and it 

is easy to miss the short transmissions altogether. In finding the obscure problems, 

appropriate equipment like I2C protocol analyzer is needed. The protocol analyzer plays an 

important role in knowing the detailed information about the signals in the communication 

between the CubeSat kit and Arduino. Since I2C is a high-speed serial protocol, it is difficult 

to debug with a simple multimeter. Pumpkin Inc, which is the developer of CubeSat kit we 

are using, advises the use of I2C protocol analyzer as it is hard and very difficult to examine 

the signals in communication between CubeSat kit and Arduino. The logic analyzers are 

capable of examining I2C, SPI, UART, CAN and other protocols by capturing and 

displaying signals from parallel busses. The advantages of using a protocol analyzer are: 

 

 The I2C protocol analyzer is mainly used for finding why the communication 

between the devices is not working as expected by the user. 

 Protocol Analyzers understand the in-depth details of a given protocol, and can thus 

report both correct and incorrect behaviors with supporting explanations about what 

went wrong (or right) as explained in [52]. 
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8  CONCLUSION 

Literature review of several concepts associated with ROS and its applications in Robotics 

have has been extensively performed. The experimentation involved attempts to establish 

communication between Arduino and PIC24 of CubeSat. The following conclusions were 

drawn based on the literature survey and experiments conducted.  

 

1. Can  the  ROS  provide  a  foundation  for  the  Onboard  Data  Handling  (OBDH) 

subsystem of a CubeSat? 

 

Under the current working conditions, where ROS is not fully developed, there are no 

supportive features that can provide a foundation for its use in small and complicated 

embedded systems like CubeSat. The present focus of ROS is completely inclined towards 

Robot framework support. It can be concluded that, future versions of ROS can provide the 

necessary functionalities like compatible APIs and proper real-time supporting features 

which help further research to be carried out in ROS‟s use in CubeSat.     

 

2. What are the advantages and disadvantages of ROS in robotics with respect to 

CubeSat? 

 

As mentioned in the previous answer, the present focus of ROS is on Robotics and since it 

was not possible to install ROS in CubeSat, its features used in robotics are taken as a 

standard to compare with CubeSat. This led to the conclusion that, ROS has no radical 

impact on CubeSat as the advantages mentioned in results are not exclusive to ROS. Those 

features along with several other important features are also available in many other RTOS 

for use in CubeSat.  

 

3. What are the problems encountered during the communication of the CubeSat kit 

with Arduino? 

 

The experimental analysis to answer this question has led to the conclusion that there are 

several problems which can be encountered during the process of establishing 

communication and these problems are categorized into common and obscure problems. 

Importance must be given to overcome obscure problems as they are more difficult to 

eliminate without a testing tool. The use of a testing tool, which in this case is the I2C 

protocol analyzer, can clearly detect the correct and incorrect behavior for communication. It 

also gives supporting reasons as to why communication could not be established.  
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9 FUTURE WORK 

The use of ROS in CubeSats is one of the trend setting research areas in future. Few of the 

future works related to this thesis are presented below: 

 

 The recent development of ROS which is integrated with real time tool kit - Orocos 

provides a scope to research on the implementation of ROS in CubeSat by 

developing appropriate and necessary APIs and libraries in ROS. 

 

 Implementing a radio protocol like AX.25 for a simulated transceiver can be a really 

good area of future research in this field. 

 

 Arduino has useful ROS libraries and tools, which would be helpful in using it to 

design other simulated subsystems for CubeSat. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  37 

10 REFERENCES 

[1] A. Addaim, A. Kherras, E.B. Zantou, “Design of Low-cost Telecommunications 

CubeSat-class Spacecraft,” Aerospace Technologies Advancements, Thawar T. Arif (Ed.), 

ISBN: 978-953-7619-96-1.  

 

[2] J. P. Diestro, F. C. Martínez, B. G. Gómez and A. G. García, “Spain´s minisat01 On-

board data handling subsystem and On-board Software” Available from 

http://www2.dem.inpe.br/ijar/dasia96.pdf [Accessed: 17-May-2012]. 

 

[3] S. Cousins, "Exponential Growth of ROS," IEEE Robotics & Automation 

Magazine, vol.18, no.1, pp.19-20, March 2011. 

 

[4] K. Conley, ROS.org. (2012, May) ROS.org. [Online]. 

http://www.ros.org/wiki/ROS/Introduction. [Accessed: 21-May-2012] 

 

[5] J. A. Larsen and J. D. Nielsen, “Development of CubeSats in an educational context,” in 

Recent Advances in Space Technologies (RAST), 2011, 5
th
 International Conference, 2011, 

pp. 777-782. 

 

[6] H. L. Denise “Communications Infrastructure for the MOST Microsatellite Project,” 

Master's thesis, National Library of Canada., 2000.  

 

[7] D. Speer, G. Jackson and D. Raphael, "Flight computer design for the Space Technology 

5 (ST-5) mission," Aerospace Conference Proceedings, 2002. IEEE, vol. 1, pp. 1-269.  

 

[8] D. Mathur, B. W. Edwards, J. Goldstein, H. Nguyen, J. Pine, B. A. Plante, J. C. Thacker, 

C. Hoover, "An Approach for Designing Reusable, Embedded Software Components for 

Spacecraft Flight Instruments," Real-Time and Embedded Technology and Applications 

Symposium, IEEE, 2005, pp. 106-115. 

 

 [9] M. Quigley, B. Gerkey, K. Conley, J. Faust, T. Foote, J. Leibs, E. Berger, R. Wheeler, 

and A. Y. Ng, "ROS: an open-source Robot Operating System," in Proc. Open-Source 

Software workshop of the International Conference on Robotics and Automation (ICRA), 

2009. Available from: http://ai.Stanford.edu/~mquigley/papers/icra2009-ros.pdf. 

 

[10] “Innovative high performance nanosatellite science and technology demonstration 

mission,” Jayaram. S, 2009 Acta Astronautica 65 (11-12), pp. 1804-1812 

 

[11] M. Schmidt, K. Schilling, “An extensible on-board data handling software platform for 

pico satellites,” Acta Astronautica, Volume 63, Issues 11-12, December 2008, Pages 1299-

1304, ISSN 0094-5765, DOI: 10.1016/j.actaastro.2008.05.017. 

 

[12] Cousins. S, Gerkey. B, Conley. K, Garage. W, "Sharing Software with ROS [ROS 

Topics]," Robotics & Automation Magazine, IEEE, vol. 17, no. 2, June 2010, pp. 12-14. 

 

[13] A. Addaim, A. Kherras, E.B. Zantou, “DSP implementation of integrated store-and-

forward APRS payload and OBDH subsystems for low-cost small satellite,” Aerospace 

Science and Technology, Volume 12, Issue 4, June 2008, Pages 308-317, ISSN 1270-9638, 

DOI: 10.1016/j.ast.2007.08.002. 

 

[14] A. Addaim, A. Kherras, E.B. Zantou, "Design of Store and Forward Data Collection 

Low-cost Nanosatellite," Aerospace Conference, 2007 IEEE, pp.1-10, 3-10 March 2007, 

DIO: 10.1109/AERO.2007.353099. 

http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www2.dem.inpe.br/ijar/dasia96.pdf
http://www.ros.org/wiki/ROS/Introduction


  38 

 

[15] J. M. Nelson, “Persistent Military Satellite Communications Coverage Using A CubeSat 

Constellation In Low Earth Orbit,” University of Central Florida Orlando, Florida, 2010. 

 

[16] B. K. Kfzeo and J. A. Kigiv, “A Survey of CubeSat Communication Systems,” Micro, 

April 2008, pp. 1–36. 

 

[17] R. B. Johnson and A. J. Onwuegbuzie, “Mixed methods research: A research paradigm 

whose time has come,” Educational researcher, vol. 33, no. 7, pp. 14–26, 2004. 

 

[18] G. D. Crnkovic, “Constructive Research and Info computational Knowledge Generation

,” in Model-Based Reasoning in Science and Technology, vol. 314, L. Magnani, W. 

Carnielli, and C. Pizzi, Eds. Berlin, Heidelberg: Springer Berlin Heidelberg, 2010, pp. 359-

380. 

 

[19] K. Lukka, “The constructive research approach,” Case study research in logistics. 

Publications of the Turku School of Economics and Business Administration, Series B, vol. 

1, no. 2003, pp. 83-101, 2003. 

 

[20] L. Alminde and K. K. Laursen, “A strategic approach to developing space capabilities 

using CubeSat technology,” Recent Advances in Space Technologies, 2009, RAST ’09. 4th 

International Conference on, 2009, pp. 43–47. 

 

[21] “NASA - Interplanetary CubeSats: Opening the Solar System to a Broad Community at 

Lower Cost.” [Online]. Available: http://www.nasa.gov/offices/oct/early_stage_innovation/n

iac/staehle_interplanetary_cubesats.html#backtoTop. [Accessed: 21-May-2012] 

 

[22] H. Heidt, J. Puig-Suari, A. S. Moore, S. Nakasuka, and R. J. Twiggs, “CubeSat: A new 

generation of picosatellite for education and industry low-cost space experimentation,” in 

Proceedings of the 14th Annual AIAA/USU Conference on Small Satellites, 2000, pp. 1–19. 

 

[23] J. Sarik, I. Kymissis, “Lab kits using the Arduino prototyping platform,” in Frontiers in 

Education Conference (FIE), IEEE, 27-30, Oct. 2010, pp. 1-5. 

 

[24] S. Greenland and C. Clark, “CubeSat platforms as an on-orbit technology validation  

and verification vehicle,” in Pestana Conference Centre, 2010. 

 

[25] http://www.pumpkininc.com/ [Accessed: 18-May-2012]. 

 

[26] http://ww1.microchip.com/downloads/en/AppNotes/00777b.pdf 

 

[27] http://documentation.renesas.com/doc/products/tool/apn/res05b0008_r8cap.pdf 

 

[28] David A. Mellis, Arduino. [Online]. http://arduino.cc/ [Accessed: 21-May-2012]. 

 

[29] David A. Mellis, Arduino. [Online]. http://arduino.cc/en/Main/ArduinoBoardUno 

[Accessed: 18-May-2012]. 

 

[30] David A. Mellis, Arduino. [Online]. http://arduino.cc/en/Main/ArduinoBoardDiecimila 

[Accessed: 18-May-2012]. 

  

[31] http://CubeSatkit.com/ [Accessed: 19-May-2012]. 

 

[32] http://www.microchip.com/ [Accessed: 17-May-2012]. 

 

http://www.nasa.gov/offices/oct/early_stage_innovation/niac/staehle_interplanetary_cubesats.html#backtoTop
http://www.nasa.gov/offices/oct/early_stage_innovation/niac/staehle_interplanetary_cubesats.html#backtoTop
http://www.pumpkininc.com/
http://ww1.microchip.com/downloads/en/AppNotes/00777b.pdf
http://documentation.renesas.com/doc/products/tool/apn/res05b0008_r8cap.pdf
http://arduino.cc/
http://arduino.cc/en/Main/ArduinoBoardUno
http://arduino.cc/en/Main/ArduinoBoardDiecimila
http://cubesatkit.com/
http://www.microchip.com/


  39 

[33] http://www.pumpkininc.com/content/doc/manual/SalvoUserManual-v3.2.3.pdf 

 

[34] http://arduino.cc/en/Guide/Windows#toc1 [Accessed: 18-May-2012]. 

 

[35] S. Cousins, “Welcome to ROS Topics”, Robotics & Automation Magazine, IEEE, 2010, 

pp. 13-14.  

 

[36] http://ww1.microchip.com/downloads/en/DeviceDoc/MPLAB_ICD3_UG_51766a.pdf 

 

[37] M. Quigley, K. Conley, B. P. Gerkey, F. Josh, F. Tully, L. Jeremy, W. Rob, N. Y. 

Andrew, “ROS: an open-source Robot Operating System,” ICRA Workshop on Open Source 

Software, Computer Science Department, Stanford University, Stanford, CA, Willow 

Garage, Menlo Park, University of Southern California, 2009. 

 

[38] http://www.ros.org/wiki/ROS/Introduction [Accessed: 21-May-2012].     

 

[39] http://www.ros.org/wiki/ROS/Installation [Accessed: 18-May-2012]. 

 

[40] http://www.ros.org/wiki/ROS/Concepts [Accessed: 18-May-2012]. 

 

[41] http://www.i2c-bus.org/obscure-problems/ [Accessed: 20-May-2012]. 

 

[42] T. Straszheim, B. Gerkey, S. Cousins, “The ROS Build System”, Robotics & Automatio

n Magazine, IEEE, 2011, pp. 18-122.  

 

[43] Q. Yu, H. Wei, M. Liu, and T. Wang, “A novel multi-OS architecture for robot 

application,” in Robotics and Biomimetics (ROBIO), IEEE International Conference on, 

2011, pp. 2301 –2306. 

 

[44] S. Cousins, B. Gerkey, K. Conley, W. Garage, “Sharing Software with ROS”, Robotics 

& Automation Magazine, IEEE, 2010, pp. 12-14. 

 

[45] D. Kononchuk, V. Kandoba, S. Zhigalov, P. Abduramanov, and Y. Okulovsky, 

“RoboCoP: A Protocol for Service-Oriented Robot Control Systems,” in Research and 

Education in Robotics - EUROBOT 2011, vol. 161, D. Obdržálek and A. Gottscheber, Eds. 

Springer Berlin Heidelberg, 2011, pp. 158–171. 

 

[46] C. J. McNutt, R. Vick, H. Whiting, and J. Lyke, “Modular Nanosatellites–

(Plug and Play) PnP CubeSat,” in 7th Responsive Space Conference, Los Angeles, CA, 

2009. 

 

[47] Saqib Mehmood, Muhammad Imran Shahzad, "Control of Articulated Robot Arm by 

Eye Tracking," Blekinge Institute of Technology, Karlsakrona, Sweden., Master Thesis 

MCS-2010-33, September, 2010. 

 

[48] M. Quigley, B. Gerkey, K. Conley, J. Faust, T. Foote, J. Leibs, E. Berger, R. Wheeler, 

and A. Ng. ROS: an open-source Robot Operating System. In Open-Source Software 

workshop of the International Conference on Robotics and Automation, 2009. 

 

[49] T. Booysen, M. Rieger, and A. Ferrein, “Towards Inexpensive Robots for Science and 

Technology Teaching and Education in Africa,” in AFRICON, 2011, 2011, pp. 1–6. 

 

[50] http://www.cubesatshop.com [Accessed: 19-May-2012]. 

 

http://www.pumpkininc.com/content/doc/manual/SalvoUserManual-v3.2.3.pdf
http://arduino.cc/en/Guide/Windows#toc1
http://ww1.microchip.com/downloads/en/DeviceDoc/MPLAB_ICD3_UG_51766a.pdf
http://www.ros.org/wiki/ROS/Introduction
http://www.ros.org/wiki/ROS/Installation
http://www.ros.org/wiki/ROS/Concepts
http://www.i2c-bus.org/obscure-problems/
http://www.cubesatshop.com/


  40 

[51] K. Buys, S. Bellens, W. Decre, R. Smits, E. Scioni, T. D. Laet, J. D. Schutter, H. 

Bruyninckx, “Haptic coupling with augmented feedback between two KUKA Light-Weight 

Robots and the PR2 robot arms” Department of Mechanical Engineering, Katholieke 

Universiteit, Intelligent Robots and Systems (IROS), IEEE/RSJ International Conference, 

25-30 Sept. 2011, Leuven, Belgium, pp. 3031-3038. 

 

[52] http://www.i2cprotocolanalyzer.com/ [Accessed: 19-May-2012]. 

 

[53] Jason Axelson, "Design of a CubeSat Payload Interface," University of Hawai, Mānoa 

Honolulu, Phd Thesis, 2009. 

 

[54] Alexandru Catalin Munteanu, "Nanosat/ Cubesat Contellation Concepts," Luleå 

University of Technology, Luleå, Sweden, Master‟s Thesis 2009:092-ISSN: 1653-0187, 

2008-09. 

 

 

 

 

 

 

 

 

http://www.i2cprotocolanalyzer.com/

